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Copyright and Trademarks

Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko
Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither
is any liability assumed for damages resulting from the use of the information herein. The information contained
herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson Approved
Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson
Corporation.

EPSON® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark
of Seiko Epson Corporation.

Intel® is a registered trademark of Intel Corporation.

PowerPC® is a registered trademark of International Business Machines Corporation.

Epson Scan software is based in part on the work of the Independent JPEG Group.

libtiff

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics
may not be used in any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED
OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

Apple®, Macintosh®, Mac OS®, and OS X® are registered trademarks of Apple Inc.

ABBYY® and ABBYY FineReader® names and logos are registered trademarks of ABBYY Software House.

Adobe, Adobe Reader, Acrobat, and Photoshop are trademarks of Adobe systems Incorporated, which may be
registered in certain jurisdictions.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their
respective owners. Epson disclaims any and all rights in those marks.

© 2012 Seiko Epson Corporation. All rights reserved.
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Introduction

Where to Find Information

The latest version of the following manuals are available on the Epson support website.
http://support.epson.net/

❏ Start Here (paper):

Provides you with information on setting up the product and installing the software.

❏ Basic Guide (paper):

Provides you with basic information when you are using the product without a computer.

❏ User’s Guide (PDF):

Provides you with detailed operating, safety, and troubleshooting instructions. See this guide when using this
product with a computer.
To view the PDF manual, you need Adobe Acrobat Reader 5.0 or later, or Adobe Reader.

❏ Network Guide (HTML):

Provides network administrators with information on both the printer driver and network settings.

Caution, Important and Note

Caution, Important, and Note in this manual are indicated as below and have the following meaning.

!Caution
must be followed carefully to avoid bodily injury.

c Important
must be observed to avoid damage to your equipment.

Note
contain useful tips and restrictions on product operation.

Operating System Versions

In this manual, the following abbreviations are used.

❏ Windows 7 refers to Windows 7 Home Basic, Windows 7 Home Premium, Windows 7 Professional, and
Windows 7 Ultimate.
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❏ Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, Windows
Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate Edition.

❏ Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and Windows XP
Professional.

❏ Mac OS X refers to Mac OS X 10.5.8 or later.
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this product. Make sure you keep this guide for future
reference. Also, be sure to follow all warnings and instructions marked on the product.

❏ Use only the power cord supplied with the product and do not use the cord with any other equipment. Use of other
cords with this product or the use of the supplied power cord with other equipment may result in fire or electric
shock.

❏ Be sure your AC power cord meets the relevant local safety standard.

❏ Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the product’s guides.

❏ Unplug the product and refer servicing to qualified service personnel under the following conditions:
The power cord or plug is damaged; liquid has entered the product; the product has been dropped or the casing
damaged; the product does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

❏ Place the product near a wall outlet where the plug can be easily unplugged.

❏ Do not place or store the product outdoors, near excessive dirt or dust, water, heat sources, or in locations subject
to shocks, vibrations, high temperature or humidity.

❏ Take care not to spill liquid on the product and not to handle the product with wet hands.

❏ Keep this product at least 22 cm away from cardiac pacemakers. Radio waves from this product may adversely
affect the operation of cardiac pacemakers.

❏ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

❏ Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning
(for fax capable model).

❏ Do not use a telephone to report a gas leak in the vicinity of the leak (for fax capable model).

Note:
The following provides safety instructions for ink cartridges.
& “Replacing Ink Cartridges” on page 78

Product Advisories and Warnings

Read and follow these instructions to avoid damaging the product or your property. Make sure you keep this guide for
future reference.
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Setting up/using the product

❏ Do not block or cover the vents and openings in the product.

❏ Use only the type of power source indicated on the product’s label.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

❏ The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over. Be
particularly careful to keep all the power-supply cords straight at the ends and the points where they enter and
leave the transformer.

❏ If you use an extension cord with the product, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.

❏ If you plan to use the product in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the product.

❏ When connecting the product to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may
damage both devices connected by the cable.

❏ Place the product on a flat, stable surface that extends beyond the base of the product in all directions. If you place
the product by the wall, leave more than 10 cm between the back of the product and the wall. The product will not
operate properly if it is tilted at an angle.

❏ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

❏ Allow spaces behind the product for the cables, and space above the product so that you can fully raise the
document cover.

❏ Leave enough space in front of the product for the paper to be fully ejected.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the product away from direct
sunlight, strong light, or heat sources.

❏ Do not insert objects through the slots in the product.

❏ Do not put your hand inside the product or touch the ink cartridge during printing.

❏ Do not touch the white flat cable inside the product.

❏ Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause
fire.

❏ Do not move the ink cartridge holder by hand; otherwise, you may damage the product.
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❏ Always turn the product off using the P button. Do not unplug the product or turn off the power at the outlet until
the LCD screen has turned off completely.

❏ Before transporting the product, make sure that the print head is in the home (far right) position and the ink
cartridge is in place.

❏ Be careful not to trap your fingers when closing the scanner unit.

❏ If you are not going to use the product for a long period, be sure to unplug the power cord from the electrical
outlet.

❏ Do not press too hard on the scanner glass when placing the originals.

❏ During the life of your product it may be necessary to replace the waste ink pad when it has become full. Whether
and how often this is required will vary according to the number of pages you print, the type of material that you
print and the number of cleaning cycles that the product performs. Epson Status Monitor, your LCD, or lights on
the control panel will advise you when this part needs replacing. The need for replacement of the pad does not
mean that your product has ceased to operate in accordance with its specifications. The replacement of this part is
a routine product servicing activity within the product’s specification and is not a problem which requires repair.
The Epson warranty does not therefore cover the cost of this replacement. If your product needs the pad replacing
this can be performed for you by any authorised Epson service provider. It is not a user-serviceable part.

Using the product with a wireless connection

❏ Do not use this product inside medical facilities or near medical equipment. Radio waves from this product may
adversely affect the operation of electrical medical equipment.

❏ Do not use this product near automatically controlled devices such as automatic doors or fire alarms. Radio waves
from this product may adversely affect these devices, and could lead to accidents due to malfunction.

Using the LCD screen

❏ The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

❏ Only use a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

❏ The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the panel
surface chips or cracks, and do not touch or attempt to remove the broken pieces.

Handling ink cartridges

We will provide ink-related safety instructions and product advice/warnings in the linked section (before “Replacing
Ink Cartridges” section).

& “Replacing Ink Cartridges” on page 78

Restrictions on Copying

Observe the following restrictions in order to ensure the responsible and legal use of the product.
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Copying of the following items is prohibited by law:

❏ Bank bills, coins, government-issued marketable securities, government bond securities, and municipal securities

❏ Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

❏ Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

❏ Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

❏ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

❏ Products can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Protecting Your Personal Information

Fax capable model allows you to store names and telephone numbers in its memory even when the power is turned
off.

Use the following menu to erase the memory if you give the product to someone else or dispose of it.

Press x and select Restore Default Settings > Reset All Settings.
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Getting to Know Your Product

Product Parts

Note:
The illustrations in this manual are from a similar product model. Although they may differ from your actual product, the
method of operation is the same.

a. ADF cover

b. Automatic Document Feeder (ADF)

c. Edge guide

d. ADF input tray (place your originals here to be copied)

e. ADF output tray (your originals are ejected here as they are copied)

a. Edge guide

b. Rear paper feed

c. Paper support extension

d. Paper support
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e. Feeder guard

f. Output tray

g. Stopper

a. Document cover

b. Scanner glass

c. Control panel

a. Scanner Unit

b. Ink cartridge holder

c. Print head (under the ink cartridge holder)
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a. AC inlet

b. LAN port

c. EXT. port*

d. LINE port*

e. USB connector

* The availability of this part varies by product.

Guide to the Control Panel

Note:
Although the control panel design and menu and option names and other items in the LCD display may slightly differ from
the actual product, the method of operation is the same.
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* emits a beep.

Buttons and LCD

Buttons Function

a Turns the product on and off.

b Enters copy mode.

c Enters fax mode.

d Enters scan mode.

e - LCD screen

f l, u, r, d, OK Press l, u, r, d to select menus. Press OK to confirm the setting you have selected and go to next
screen. When typing a fax number, l acts as a backspace key, and r inserts a space.

g 0-9,*,# Specifies the date/time or the number of copies, as well as fax numbers. Enters alphanumeric
characters and switches between uppercase, lowercase, and numbers each time it is pressed. Press 1
symb to enter symbols such as the sharp sign (#), plus (+), and apostrophe (’).

h Displays speed dial/group dial lists. Press again to switch lists.

i Displays the last number dialed. When entering numbers in fax mode, this inserts a pause symbol (-)
that acts as a brief pause during dialing.

j Stops the ongoing operation or initialize the current settings.
If this button is pressed to cancel copying, scanning, or faxing while the ADF is in use, all originals in the
ADF will be fed out.

k Displays detailed settings for each mode.

l Cancels/returns to the previous menu.

m Displays the Wi-Fi Setup menus that allow you to set up the product wirelessly. For instructions on
using the menus, see the Network Guide.

n Start copying/faxing.
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Lights

Lights Function

On when the product is on.
Flashes when the product is receiving data, printing/copying/scanning/faxing, replacing an ink cartridge,
charging ink, or cleaning the print head.

Stays on while the product is connected to a Wi-Fi network. Flashes while the Wi-Fi network settings are being
made. This light turns off in sleep mode.

ADF On when originals are detected in the ADF.

     User’s Guide

Getting to Know Your Product

17



Paper and Media Handling

Introduction to Using, Loading, and Storing Media

You can achieve good results with most types of plain paper. However, Epson provides special types of paper that is
formulated for the ink used in Epson ink jet products, and we recommend using this paper to ensure high-quality
results.

When loading special paper distributed by Epson, read the instruction sheets packed with the paper first and keep the
following points in mind.

Note:
❏ Load the paper into the rear paper feed printable side up. The printable side is usually whiter. See the instruction sheets

packed with the paper for more information. Some types of paper have cut corners to help identify the correct loading
direction.

❏ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may
cause ink to smear on your prints. Do not use the paper that is folded, wavy or torn.

Storing paper

Return unused paper to the original package as soon as you finish printing. Keep unused paper and prints away from
high temperature, humidity, and direct sunlight.

Selecting Paper

The table below lists supported papers. Loading capacity availability varies by paper as shown.
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Media Type Size Loading capacity (sheets)

Plain paper*1 Letter*2 up to 11mm

A4*2 up to 11mm

B5*2 up to 11mm

A5*2 up to 11mm

A6*2 up to 11mm

Legal 1

User Defined 1

Envelope #10 10

DL 10

C6 10

Epson Bright White Ink Jet Paper A4*2 80

Epson Photo Quality Ink Jet Paper A4 80

Epson Matte Paper - Heavyweight A4 1

*1 Paper with a weight of 64 g/m2 (17 lb) to 90 g/m2 (24 lb).

*2 The loading capacity for manual 2-sided printing is 30 sheets.

Note:
The availability of paper varies by location.

Paper type settings on the LCD screen

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper LCD paper type

Plain paper Plain Paper

Epson Bright White Ink Jet Paper

Epson Matte Paper - Heavyweight Matte

Paper type settings from the printer driver

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.
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For this paper Printer driver paper type

Plain paper plain papers

Epson Bright White Ink Jet Paper

Epson Matte Paper – Heavyweight Epson Matte

Epson Photo Quality Ink Jet Paper

Envelopes Envelope

Note:
The availability of special media varies by location. For the latest information on media available in your area, contact
Epson support.
& “Technical Support Web Site” on page 136

Loading Paper and Envelopes

Follow these steps to load paper:

A Flip the feeder guard forward.

B Slide out the paper support and the output tray and then raise the stopper.

Note:
Leave enough space in front of the product for the paper to be fully ejected.
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C Slide the edge guide to the left.

D Load paper with the printable side up, against the right side of the rear paper feed.

Note:
❏ Fan and align the edges of the paper before loading.

❏ The printable side is often whiter than the other side.

❏ Always load paper into the rear paper feed short edge first, even when you are printing landscape -oriented
pictures.

❏ You can use the following sizes of paper with binding holes: A4, A5, A6, Legal, Letter. Load only 1 sheet of paper
at a time.

❏ When loading envelopes, load the short edge first with the flap facing down.

❏ Do not use envelopes that are curled, folded, or glued or that have plastic windows.

❏ Flatten the envelope and the flaps before loading.

❏ Flatten the leading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin, as they may curl during printing.
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E Slide the edge guide against the left edge of the paper, but not too tightly.

Note:
For plain paper, do not load paper above the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.

& “Selecting Paper” on page 18

F Flip the feeder guard back.

Placing Originals

Automatic Document Feeder (ADF)

You can load your original documents in the Automatic Document Feeder (ADF) to copy, scan, or fax multiple pages
quickly. You can use the following originals in the ADF.

Size A4/Letter/Legal

Type Plain paper

Weight 64 g/m2 to 95 g/m2

Capacity Total thickness of 3 mm, up to about 30 sheets (Letter, A4) 10 sheets (Legal)

     User’s Guide

Paper and Media Handling

22



c Important:
To prevent paper jams, avoid the following documents. For these types, use the scanner glass.

❏ Documents held together with paper clips, staples, etc.

❏ Documents that have tape or paper stuck to them.

❏ Photos, OHPs, or thermal transfer paper.

❏ Paper that is torn, wrinkled, or has holes.

A Make sure that there are no originals on the scanner glass. The ADF may not detect documents in the feeder if
there are originals on the scanner glass.

B Tap the originals on a flat surface to even the edges.

C Slide the edge guide on the Automatic Document Feeder.

D Insert the originals face-up and short edge first into the Automatic Document Feeder.
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E Slide the edge guide until it is flush with the originals.

F Check that the ADF light in the control panel is on.

Note:
❏ The ADF light may stay off if there is any other original on the scanner glass. If you press x in this case, the

original on the scanner glass will be copied, scanned, or faxed instead of the originals in the ADF.

❏ The ADF light will not turn on when the product is in sleep mode. Press any button other than P to recover from
sleep mode. It may take some time for the light to turn on after recovery from sleep mode.

❏ Be careful not to let any foreign object get inside the hole on the left front corner of the scanner glass. Doing so
may prevent the ADF from operating.

❏ When you use the copy function with the Automatic Document Feeder (ADF), the print settings are fixed at
Reduce/Enlarge - Actual Size, Paper Type - Plain Paper, and Paper Size - A4/Legal. The print is cropped if you
copy an original larger than A4/Legal.

Scanner glass

A Open the document cover and place your original face-down on the scanner glass.
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B Slide the original to the corner.

Note:
See the following sections if any problems occur with the scanning area or the scanning direction when using EPSON
Scan.

& “The edges of your original are not scanned” on page 125 
& “Multiple documents are scanned into a single file” on page 126

C Close the cover gently.
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Copying

Copying Documents

Basic copying

Follow the steps below to copy documents.

A Load paper.
& “Loading Paper and Envelopes” on page 20

B Place your original(s) in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 22

C Press r to enter the copy mode.

D Press u or d to set the number of copies.

E Press x to display the copy setting menus.

F Select the appropriate copy settings such as layout, paper size, paper type, and quality. Use u or d to select a
setting item and then press OK. When finished, press x again to return to the copy mode top screen.

G Press x to start copying.

Copy Mode Menu List

Refer to the section below for the Copy mode menu list.
& “Copy Mode” on page 73
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Printing

Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results. The status monitor and
the printer utilities help you check the product and keep it in top operating condition.

Note for Windows users:
❏ Your printer driver automatically finds and installs the latest version of the printer driver from Epson’s Web site. Click

the Software Update button in your printer driver’s Maintenance window, and then follow the on-screen instructions.
If the button does not appear in the Maintenance window, point at All Programs or Programs in the Windows Start
menu, and check in the EPSON folder.

❏ If you want to change the language of the driver, select the language you want to use from the Language setting in your
printer driver’s Maintenance window. Depending on the location, this function may not be available.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the Windows Start menu, or the taskbar.

To make settings that apply only to the application you are using, access the printer driver from that application.

To make settings that apply to all of your Windows applications, access the printer driver from the Start menu or the
taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows 7.

From Windows applications

A Click Print or Print Setup on the File menu.

B In the window that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on your
application, you may need to click one or a combination of these buttons.)

From the Start menu

❏ Windows 7: 
Click the start button, select Devices and Printers. Then right-click the product and select Printing
preferences.

❏ Windows Vista: 
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.
Then select the product and then click Select printing preferences.
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❏ Windows XP: 
Click Start, Control Panel, (Printers and Other Hardware,) then Printers and Faxes. Select the product, then
click Printing Preferences on the File menu.

From the shortcut icon on the taskbar

Right-click the product icon on the taskbar, then select Printer Settings.

To add a shortcut icon to the Windows taskbar, first access the printer driver from the Start menu as described above.
Next, click the Maintenance tab, and then the Monitoring Preferences button. In the Monitoring Preferences
window, select the Shortcut Icon check box.

Getting information through online help

In the printer driver window, try one of the following procedures.

❏ Right-click the item, then click Help.

❏ Click the  button at the top right of the window, then click the item (for Windows XP only).

Accessing the printer driver for Mac OS X

The table below describes how to access the printer driver dialog.

Dialog Box How to Access It

Page Setup Click Page Setup on the File menu of your application.

Note:
Depending on your application, the Page Setup menu may not appear in the File menu.

Print Click Print on the File menu of your application.

Epson Printer Utility 4 For Mac OS X 10.7, click System Preferences on the Apple menu and then click Print & Scan.
Select your product from the Printers list box, click Options & Supplies, Utility, and then click
Open Printer Utility.

For Mac OS X 10.6, click System Preferences on the Apple menu and then click Print & Fax. Select
your product from the Printers list box, click Options & Supplies, Utility, and then click Open
Printer Utility.

For Mac OS X 10.5, click System Preferences on the Apple menu and then click Print & Fax. Select
your product from the Printers list box, click Open Print Queue and then click Utility button.

Getting information through online help

Click the  Help button in the Print dialog box.
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Basic Operations

Basic printing

Note:
❏ The screen shots in this section may vary depending on the model.

❏ Before you print, load paper properly.
& “Loading Paper and Envelopes” on page 20

❏ Refer to the section below for the printable area.
& “Printable area” on page 131

❏ After completing the settings, print one test copy and examine the results before printing an entire job.

Basic product settings for Windows

A Open the file you want to print.

B Access the printer settings.
& “Accessing the printer driver for Windows” on page 27

C Click the Main tab.

D Select the appropriate Document Size setting. You can also define a custom paper size. For details, see the online
help.
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E Select Portrait (tall) or Landscape (wide) to change the orientation of your print.

Note:
Select Landscape when printing on envelopes.

F Select the appropriate Paper Type setting.
& “Paper type settings from the printer driver” on page 19

Note:
Print quality is automatically adjusted for the selected Paper Type.

G Click OK to close the printer settings window.

Note:
To make changes to advanced settings, refer to the relevant section.

H Print your file.

Basic product settings for Mac OS X

Note:
Screen shots of the printer driver windows in this section are from Mac OS X 10.7.

A Open the file you want to print.
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B Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 28

Note:
If the simplified dialog box is displayed, click the Show Details button (for Mac OS X 10.7) or the d button (for Mac
OS X 10.6 or 10.5) to extend this dialog box.

C Select the product you are using as the Printer setting.

Note:
Depending on your application, you may not be able to select some of the items in this dialog box. If so, click Page
Setup on the File menu of your application, and then make suitable settings.

D Select the appropriate Paper Size setting.

E Select the appropriate Orientation setting.

Note:
Select landscape orientation when printing envelopes.
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F Select Print Settings from the pop-up menu.

G Select the appropriate Media Type setting.
& “Paper type settings from the printer driver” on page 19

H Click Print to start printing.

Canceling printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the product button

Press y to cancel a print job in progress.
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For Windows

Note:
You cannot cancel a print job that has been completely sent to the product. In this case, cancel the print job by using the
product.

A Access the EPSON Status Monitor 3.
& “For Windows” on page 104

B Click the Print Queue button. The Windows Spooler appears.

C Right-click on the job you want to cancel and then select Cancel.

For Mac OS X

Follow the steps below to cancel a print job.

A Click your product icon in the Dock.

B In the Document Name list, select the document which is printing.

C Click the Delete button to cancel the print job.

Other Options

Product presets (For Windows Only)

Printer driver presets make printing a snap. You can also create presets of your own.
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Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 27

B Select a Printing Presets in the Main tab. Product settings are automatically set to the values displayed in the
pop-up window.

2-sided printing (for Windows only)

Use the printer driver to print on both sides of the paper.

Two types of 2-sided printing are available: standard and folded booklet.

2-sided printing is only available for the following papers and sizes.

Paper Size

Plain paper Legal, Letter, A4, B5, A5, A6

Epson Bright White Ink Jet Paper A4

Note:
❏ This feature is not available for Mac OS X.

❏ This feature may not be available at some settings.

❏ This feature may not be available when the product is accessed over a network or is used as a shared printer.

❏ The loading capacity differs during 2-sided printing.
& “Selecting Paper” on page 18

❏ Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may deteriorate.

❏ Depending on the paper and the amount of ink used to print text and images, ink may bleed through to the other side of
the paper.

❏ The surface of the paper may be smeared during 2-sided printing.

❏ This feature is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer
driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window,
check the Enable EPSON Status Monitor 3 check box.
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Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 27

B Select 2-Sided Printing check box.

C Click Settings, and make the appropriate settings.

Note:
If you want to print a folded booklet, select Booklet.

D Check the other settings and print.

Note:
❏ The actual binding margin may be different from the specified settings depending on your application.

Experiment with a few sheets to examine actual results before printing the entire job.

❏ Make sure that the ink is completely dry before reloading the paper.

Fit to page printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer driver.

Note:
This feature may not be available at some settings.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 27

B Select Reduce/Enlarge Document and Fit to Page in the More Options tab, and then select the size of the paper
you are using from Output Paper.
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C Check the other settings and print.

Product settings for Mac OS X

A Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 28

B Choose Scale to fit paper size for Destination Paper Size in the Paper Handling pane and select the desired
paper size from the pop-up menu.

C Check the other settings and print.

Pages per sheet printing

Lets you use the printer driver to print two or four pages on a single sheet of paper.

Note:
This feature may not be available at some settings.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 27

B Select 2-Up or 4-Up as Multi-Page in the Main tab.

C Click Page Order, and make the appropriate settings.

D Check the other settings and print.
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Product settings for Mac OS X

A Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 28

B Select the desired number of Pages per Sheet and the Layout Direction (page order) in the Layout pane.

C Check the other settings and print.

Sharing the Product for Printing

Setup for Windows

These instructions tell you how to set up your product so other users on the network can share it.

First you will set up the product as a shared printer on the computer directly connected to it. Then you will add the
product to each network computer that will access it.

Note:
❏ These instructions are for small networks only. To share the product on a large network, consult your network

administrator.

❏ The screen shots in the following section are from Windows 7.

Setting up the product as a shared printer

Note:
❏ To set up the product as a shared printer in Windows 7 or Vista, you will need an account with administrator privileges

and the password if you log on as a standard user.

❏ To set up the product as a shared printer in Windows XP, you must log on to a Computer Administrator account.

Follow the steps below on the computer that is connected directly to the product:

A Windows 7: 
Click the start button, select Devices and Printers.

Windows Vista: 
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP: 
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.
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B Windows 7: 
Right-click the icon for your product, click Printer properties, and then click Sharing. Then click the Change
Sharing Options button.

Windows Vista: 
Right-click the icon for your product, and then click Sharing. Click the Change sharing options button and
then click Continue.

Windows XP: 
Right-click the icon for your product, then click Sharing.

C Select Share this printer, then type a Share name.

Note:
Do not use spaces or hyphens in the share name.

If you want to automatically download printer drivers for computers that are running different versions of
Windows, click Additional Drivers and select the environment and the operating systems of the other
computers. Click OK, then insert the product software disk.

D Click OK or Close (if you installed additional drivers).

Adding the product to the other network computers

Follow these steps to add the product to each network computer that will access it.
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Note:
Your product must be set up as a shared printer on the computer to which it is connected before you can access it from
another computer.
& “Setting up the product as a shared printer” on page 37.

A Windows 7: 
Click the start button, select Devices and Printers.

Windows Vista: 
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP: 
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

B Windows 7 and Vista: 
Click the Add a printer button.

Windows XP: 
Click the Add a printer button. The Add Printer Wizard appears. Click the Next button.

C Windows 7 and Vista: 
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP: 
Select A network printer, or a printer attached to another computer, then click Next.

D Follow the on-screen instructions to select the product you want to use.

Note:
Depending on the operating system and the configuration of the computer to which the product is connected, the Add Printer
Wizard may prompt you to install the printer driver from the product software disk. Click the Have Disk button and follow
the on-screen instructions.
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Setup for Mac OS X

To set up your product on a Mac OS X network, use the Printer Sharing setting. See your Macintosh documentation for
details.
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Scanning

Let’s Try Scanning

Starting a Scan

Let’s scan a document to get used to the process.

A Place your original(s) on the scanner glass.
& “Placing Originals” on page 22

B Start Epson Scan.

❏ Windows:
Double-click the Epson Scan icon on the desktop.

❏ Mac OS X:
Select Applications > Epson Software > EPSON Scan.

C Select Home Mode.
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D Select Text/Line Art as the Document Type setting.

E Click Preview.

F Click Scan.
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G Click OK.

Your scanned image is saved.

Image Adjustment Features

Epson Scan offers a variety of settings for improving color, sharpness, contrast, and other aspects affecting image
quality.

See the Help for more details on Epson Scan.

Histogram Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually.
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Tone Correction Provides a graphical interface for adjusting tone levels individually.

Image Adjustment Adjusts brightness and contrast and the balance of red, green, and blue colors in the overall
image.

Color Palette Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting
the highlight and shadow areas of the image.

Unsharp Mask Sharpens the edges of image areas for an overall clearer image.

Descreening Removes rippled patterns (known as moiré) that can appear in subtly shaded image areas such as
skin tones.
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Color Restoration Restores the colors in faded photos automatically.

Backlight Correction Removes shadows from photos that have too much background light.

Dust Removal Removes dust marks from your originals automatically.

Text Enhancement Enhances text recognition when scanning text documents.

Auto Area Segmentation Makes Black&White images clearer and text recognition more accurate by separating the text
from the graphics.

Color Enhance Enhance a certain color. You can select from red, blue, or green.
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Basic Scanning from the Control Panel

You can scan documents and send the scanned image from the product to a connected computer. Make sure you have
installed software for the product on your computer and connected to the computer.

A Place your original(s) in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 22

B Press  to enter the scan mode.

C Select a scan menu item. Use u or d to select a menu, and press OK.

& “Scan Mode” on page 77

D Select your computer.

Note:
❏ If the product is connected to a network, you can select the computer to which you want to save the scanned

image.

❏ You can change the computer name displayed on the control panel using Epson Event Manager.

E Press OK to start scanning.

Your scanned image is saved.

Scan mode menu list

Refer to the section below for the Scan mode menu list.
& “Scan Mode” on page 77

Basic Scanning from Your Computer

Scanning in Home Mode

Home Mode lets you customize some scanning settings and check the changes you have made in a preview image. This
mode is useful for basic scanning of photos and graphics.

Note:
❏ In Home Mode, you can only scan from the scanner glass.

❏ See the Help for more details on Epson Scan.

A Place your original(s).
& “Scanner glass” on page 24
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B Start Epson Scan.
& “Starting Epson Scan Driver” on page 59

C Select Home Mode from the Mode list.

D Select the Document Type setting.

E Select the Image Type setting.

F Click Preview.
& “Previewing and Adjusting the Scan Area” on page 52

G Adjust the exposure, brightness, and other image quality settings.

H  Click Scan.
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I  In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Office Mode

Office Mode lets you quickly scan text documents without previewing your image.

Note:
See the Help for more details on Epson Scan.

A Place your original(s).
& “Placing Originals” on page 22

Note for the Automatic Document Feeder (ADF):
❏ If you are using preview function, load only the first page.

❏ Do not load paper above the line just under the d arrow mark on the ADF.

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 59
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C Select Office Mode from the Mode list.

D Select the Image Type setting.

E Select the Document Source setting.

F Select the size of your original as the Size setting.

G Select an appropriate resolution for your original(s) as the Resolution setting.

H Click Scan.
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I In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Professional Mode

Professional Mode gives you total control of your scanning settings and lets you check the changes you have made in a
preview image. This mode is recommended for advanced users.

Note:
See the Help for more details on Epson Scan.

A Place your original(s).
& “Placing Originals” on page 22

Note for the Automatic Document Feeder(ADF):
If you are using preview function, load only the first page.

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 59
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C Select Professional Mode from the Mode list.

D Select the type of original(s) you are scanning as the Document Type setting.

E Select the Document Source setting.

F If you select Reflective as the Document Type setting, select Photo or Document as the Auto Exposure Type
setting.
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G Select the Image Type setting.

H Select an appropriate resolution for your original(s) as the Resolution setting.

I Click Preview to preview your image(s). The Preview window opens and displays your image(s).
& “Previewing and Adjusting the Scan Area” on page 52

Note for the Automatic Document Feeder (ADF):
❏ The ADF loads your first document page, and then Epson Scan prescans it and displays it in the Preview

window. The ADF then ejects your first page.
Place your first document page on top of the rest of the pages, and then load the entire document into the ADF.

❏ Do not load paper above the line just under the d arrow mark on the ADF.

J Select the size of the scanned image(s) as the Target Size setting if necessary. You can scan your images at their
original size, or you can reduce or enlarge their size by selecting Target Size.

K Adjust the image quality if necessary.
& “Image Adjustment Features” on page 43

Note:
You can save the settings you make as a group of custom settings with a Name, and later apply these custom settings
when scanning. Your custom settings are also available in Epson Event Manager.

See the Help for more details on Epson Event Manager.

L  Click Scan.

M  In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Previewing and Adjusting the Scan Area

Selecting a preview mode

Once you have selected your basic settings and resolution, you can preview your image and select or adjust the image
area in a Preview window. There are two types of preview.

❏ Normal preview displays your previewed image(s) in their entirety. You can select the scan area and make any
image quality adjustments manually.

❏ Thumbnail preview displays your previewed image(s) as thumbnail(s). Epson Scan automatically locates the
edges of your scan area, applies automatic exposure settings to the image(s), and rotates the image(s) if necessary.
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Note:
❏ Some of the settings that you change after previewing an image are reset if you change the preview mode.

❏ Depending on your document type and the Epson Scan mode you are using, you may not be able to change the preview
type.

❏ If you preview image(s) without the Preview dialog displayed, image(s) are displayed in the default preview mode. If you
preview with the Preview dialog displayed, image(s) are displayed in the preview mode that was displayed just before
previewing.

❏ To resize the Preview window, click and drag the corner of the Preview window.

❏ See the Help for more details on Epson Scan.

Creating a marquee

A marquee is a moving dotted line that appears on the edges of your preview image to indicate the scan area.

Do one of the following to draw a marquee.

❏ To draw the marquee manually, position the pointer in the area where you want to place the corner of your
marquee and click. Drag the cross-hairs over the image to the opposite corner of the desired scan area.

❏ To draw the marquee automatically, click the  auto locate icon. You can only use this icon when you are
viewing a normal preview and you only have one document on the scanner glass.

❏ To draw the marquee at a specified size, type in a new width and height in the Document Size setting.

❏ For best results and image exposure, make sure all sides of the marquee are located inside the preview image. Do
not include any areas around the preview image in the marquee.

Adjusting a marquee

You can move the marquee and adjust its size. If you are viewing a normal preview, you can create multiple marquees
(up to 50) on each image to scan different image areas as separate scan files.

To move the marquee, position your cursor inside the marquee. The pointer becomes a hand. Click and
drag the marquee to the desired location.

To resize the marquee, position your cursor over the edge or corner of the marquee.

The pointer becomes a straight or angled double-arrow. Click and drag the edge or corner to the desired
size.
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To create additional marquees of the same size, click this icon.

To delete a marquee, click inside the marquee and click this icon.

To activate all marquees, click this icon.

Note:
❏ To restrict the movement of the marquee to vertical or horizontal only, hold down the Shift key as you move the

marquee.

❏ To restrict the size of the marquee to the current proportions, hold down the Shift key as you resize the marquee.

❏ If you draw multiple marquees, make sure you click All in the Preview window before you scan. Otherwise, only the area
inside the last marquee you drew will be scanned.

Various Types of Scanning

Scanning a Magazine

First of all, place your magazine and start Epson Scan.
& “Starting a Scan” on page 41

A Select Home Mode from the Mode list.
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B Select Magazine as the Document Type setting.

C Click Preview.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

E Click Scan.

F Select PDF as the Type setting, and then click OK.

Your scanned image is saved.

Scanning Multiple Documents to a PDF File

First of all, place your document and start Epson Scan.
& “Starting a Scan” on page 41

Note for the Automatic Document Feeder(ADF):
If you are using preview function, load only the first page.
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A Select Professional Mode from the Mode list.

B Select the Document Source setting.

C Click Preview.

Note for the Automatic Document Feeder (ADF):
❏ The document page ejected by the ADF has not been scanned yet. Reload the entire document into the ADF.

❏ Do not load paper above the line just under the d arrow mark on the ADF.
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D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

E Click Scan.

F Select PDF as the Type setting, and then click OK.

Note:
If the Show Add Page dialog after scanning check box is cleared, Epson Scan automatically saves your document
without displaying the Add Page Confirmation window.

G Epson Scan starts scanning your document.

H If you want to scan more pages, click Add page.
Load the document and scan again, repeating as necessary for each page.

If you have finished scanning, go to step 9.

     User’s Guide

Scanning

57



I Click Edit page or Save File.

Edit page Select this button if you want to delete or reorder any of the pages. Then use the icons on the
bottom of the Editing Page window to select, rotate, reorder, and delete pages.
See the Help for more details on Epson Scan.

Click OK when you are finished editing your pages.

Save File Select this button when you are finished.

The pages are saved in one PDF file.

Scanning a Photo

First of all, place your photo on the scanner glass and start Epson Scan.
& “Starting a Scan” on page 41
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A Select Home Mode from the Mode list.

B Select Photograph as the Document Type setting.

C Click Preview.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

E Click Scan.

F Select JPEG as the Type setting, and then click OK.

Your scanned image is saved.

Software Information

Starting Epson Scan Driver

This software lets you control all aspects of scanning. You can use this as a standalone scanning program or use it with
another TWAIN-compliant scanning program.
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How to start

❏ Windows:
Double-click the EPSON Scan icon on the desktop.
Or, select the start button icon or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON
Scan.

❏ Mac OS X:
Select Applications > Epson Software > EPSON Scan.

How to access the help

Click the Help button on the Epson Scan driver.

Starting Other Scanning Software

Note:
Some scanning software may not be included in some countries.

Epson Event Manager

This lets you assign any of the product buttons to open a scanning program. You can also save frequently used
scanning settings, which can really speed up your scanning projects.

How to start
❏ Windows:

Select the start button or Start > All Programs or Programs> Epson Software > Event Manager.

❏ Mac OS X:
Select Applications > Epson Software, and then double-click the Launch Event Manager icon.

How to access the help
❏ Windows:

Click the  icon in the upper right corner of the screen.

❏ Mac OS X:
Click menu > Help > Epson Event Manager Help.
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Faxing

Introducing FAX Utility

FAX Utility is a software capable of transmitting data such as documents, drawings, and tables created using a word
processing or spreadsheet application directly by fax, without printing. Use the following procedure to run the utility.

Windows
Click the start button (Windows 7 and Vista) or click Start (Windows XP), point to All Programs, select Epson
Software, and then click FAX Utility.

Mac OS X
Click System Preference, click Print & Fax or Print & Scan, and then select FAX (your product) from Printer. Then
click as follows;
Mac OS X 10.6.x, 10.7.x: Option & Supplies - Utility - Open Printer Utility
Mac OS X 10.5.x: Open Print Queue - Utility

Note:
For more details, see the online help for FAX Utility.

Connecting to a Phone Line

About a phone cable

Use a phone cable with the following interface specification.

❏ RJ-11 Phone Line

❏ RJ-11 Telephone set connection

Depending on the area, a phone cable may be included with the product. If so, use that cable.
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Using the phone line for fax only

A Connect a phone cable leading from a telephone wall jack to the LINE port.

B Make sure Auto Answer is set to On.

& “Setting up to receive faxes automatically” on page 70

c Important:
If you do not connect an external telephone to the product, make sure you turn on auto answer. Otherwise, you cannot
receive faxes.

Sharing line with phone device

A Connect a phone cable leading from a telephone wall jack to the LINE port.

B Remove the cap.
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C Connect a phone or answering machine to the EXT. port.

Note:
❏ See the following for other connection methods.

❏ For details, see the documentation that came with your devices.

Connecting to DSL

a Telephone wall jack

b Splitter

c DSL modem
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Connecting to ISDN (one phone number)

a ISDN wall jack

d Terminal adapter or ISDN router

Connecting to ISDN (two phone numbers)

a ISDN wall jack

d Terminal adapter or ISDN router

Checking the fax connection

You can check whether the product is ready to send or receive faxes.

A Load plain paper.
& “Loading Paper and Envelopes” on page 20

B Press K to enter the fax mode.

C Press x to display the menus.
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D Select Fax Settings > Check Fax Connection. Use u or d to select a menu, and press OK.

E Press x to print the report.

Note:
If an errors are reported, try the solutions in the report.

Notices when the power is turned off

When the product is turned off, the following data stored in the product’s temporary memory is erased.

❏ Received fax data

❏ Fax data scheduled to be sent later

❏ Fax data being transmitted automatically

Also, when the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn
the power back on.

If the product is turned off due to a power failure, it automatically restarts and beeps when the power is restored. If you
have set to receive faxes automatically (Auto Answer - On), the setting is also restored. Depending on the
circumstances before the power failure, it may not restart.

Setting Up Fax Features

Setting up speed dial entries

You can create a speed dial list allowing you to select fax recipient numbers quickly when faxing. Up to 60 combined
speed dial and group dial entries can be registered.

A Press K to enter the fax mode.

B Press x to display the menus.

C Select the menu shown below. Use u or d to select a menu, and press OK.

Select Fax Settings > Speed Dial Setup.

D Select Create. You see the available speed dial entry numbers.

E Select the speed dial entry number that you want to register. Use u or d to select a number, and press OK. You
can register up to 60 entries.
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F Use the numeric keypad to enter a phone number, and press OK. You can enter up to 64 digits.

Note:
❏ Press r to enter a space. Press l to delete numbers. Press  to enter a hyphen (-).

❏ A hyphen (“-”) causes a slight pause when dialing. Only include it in phone numbers when a pause is necessary.
Spaces entered between numbers are ignored when dialing.

G Enter a name to identify the speed dial entry. You can enter up to 30 characters.

Press OK to register the name.

Setting up group dial entries

You can add speed dial entries to a group, allowing you to send a fax to multiple recipients at the same time. Up to 60
combined speed dial and group dial entries can be entered.

A Press K to enter the fax mode.

B Press x to display the menus.

C Select the menu shown below. Use u or d to select a menu, and press OK.

Select Fax Settings > Group Dial Setup.

D Select Create. You see the available group dial entry numbers.

E Select the group dial entry number that you want to register. Use u or d to select a number, and press OK.

F Enter a name to identify the group dial entry. You can enter up to 30 characters.

Press OK to register the name.

G Select a speed dial entry that you want to register in the group dial list. Use u or d to select the entry and press 
to add it to the group.

When you want to cancel the selection, press  again.

H Repeat step 7 to add other speed dial entries to the group dial list. You can register up to 30 speed dial entries in a
group dial.

I Press OK to finish creating a group dial list.

Creating header information

You can create a fax header by adding information such as your phone number or name.

     User’s Guide

Faxing

66



Note:
Make sure you have set the time correctly.
& “Setting/Changing Time and Region” on page 93

A Press K to enter the fax mode.

B Press x to display the menus.

C Select the menu shown below. Use u or d to select a menu, and press OK.

Select Fax Settings > Header > Fax Header.

D Enter the header information. You can enter up to 40 characters.

Press OK to register the name.

E Press d to select Your Phone Number and press OK.

F Use the numeric keypad with other buttons on the control panel to enter your phone number. You can enter up
to 20 digits.

Note:
Press the # button to enter a plus sign (+) which represents the international call prefix. Note that the asterisk (*) is
unavailable.

G Press OK to register the header information.

Sending Faxes

Sending faxes by entering a number

A Place your original(s) in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 22

B Press K to enter the fax mode.

C Use the keys on the numeric keypad to enter the fax number. You can enter up to 64 digits.

If you want to send the fax to more than one recipient, press OK after entering a one fax number, and select Yes
to add another fax number.

     User’s Guide

Faxing

67



Note:
❏ To display the last fax number you used, press .

❏ You can change fax quality and contrast settings. Press x and select Quality or Contrast. When finished, press
x again to return to the fax mode top screen.

❏ Make sure you have entered the header information. Some fax machines automatically reject incoming faxes
that do not include header information.

D Press x to start sending.

Note:
If the fax number is busy or there is some problem, this product redials after one minute. Press  to redial immediately.

Sending faxes using speed dial/group dial

Follow the instructions below to send faxes using speed dial/group dial.

Note:
When using group dial, you can only send B&W faxes.

A Place your original(s) in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 22

B Press K to enter the fax mode.

C Press .

Note:
Each press of  switches between the speed dial list and group dial list.

D Select the entry number to send. Use u or d to select an entry, and press OK.

You will be prompted to add another number. You can add another number by manually entering the number
or using the speed dial or group dial.

Note:
You can change fax quality and contrast settings. Press x and select Quality or Contrast. When finished, press x
again to return to the fax mode top screen.

E Press x to start sending.

Sending a fax at a specified time

Follow the instructions below to send a fax at a specified time.
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Note:
❏ Make sure you have set the time correctly.

& “Setting/Changing Time and Region” on page 93

❏ You can only send B&W faxes.

A Place your original(s) in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 22

B Press K to enter the fax mode.

C Enter a fax number. You can also use redial, speed dial, or group dial lists to select fax number.

D Press x to display the menus.

E Select Send Fax Later. Use u or d to select the menu, and press OK.

F Press r to display the time settings.

G Set the time that you want to send the fax, and then press OK. Use r or l to move the cursor and use u or d to
select a.m. or p.m.

H Press y to return to the fax send screen.

I Press x to start scanning. The scanned image is sent at the specified time.

Note:
If you need to cancel faxing at the time you specified, press y.

Sending a fax from a connected phone

If the recipient has the same number for both phone and fax, you can send a fax after talking over the phone without
hanging up.

A Place your original(s) in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 22

B Dial a number from the phone connected to the product.
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C Select Send on the control panel of the product.

D Press x to send fax.

E Hang up the phone.

Receiving Faxes

Setting up to receive faxes automatically

Follow the instructions to make settings to receive faxes automatically.

A Load plain paper in the rear paper feed.
& “Loading Paper and Envelopes” on page 20

B Press K to enter the fax mode.

C Press x to display the menus.

D Make sure Auto Answer is set to On.

Fax Settings > Send/Receive Setup > Auto Answer > On

Note:
❏ When an answering machine is connected directly to this product, make sure you set Rings to Answer correctly

using the following procedure.

❏ Depending on the region, Rings to Answer may be unavailable.

E Press y and d to select Communication and press OK.

F Select Rings to Answer and press OK.

G Press u or d to select the number of rings and press OK.

c Important:
Select more rings than needed for the answering machine to pick up. If it is set to pick up on the fourth ring, set the
product to pick up on the fifth ring or later. Otherwise the answering machine cannot receive voice calls.
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Note:
When you receive a call and the other party is a fax, the product receives the fax automatically even if the answering machine
picks up the call. If you pick up the phone, wait until the LCD screen displays a message saying that a connection has been
made before you hang up. If the other party is a caller, the phone can be used as normal or a message can be left on the
answering machine.

Receiving faxes manually

If your phone is connected to the product, you can receive fax data after the connection is made.

A Load plain paper in the rear paper feed.
& “Loading Paper and Envelopes” on page 20

B When the telephone rings, lift the phone connected to the product.

C When you hear a fax tone, select Receive on the control panel of the product.

D Select Yes to start receiving the fax.

E Put the phone back on the hook.

Note:
If Auto Answer mode is turned on, the received fax data is automatically printed, and you do not have to proceed to
step 6.

F Press OK to print the received fax.

Receive a fax by polling

This allows you to receive a fax from the fax information service you have called.

Follow the instructions below to receive a fax by polling.

A Load plain paper in the rear paper feed.
& “Loading Paper and Envelopes” on page 20

B Press K to enter the fax mode.

C Enter the fax number.
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D Press x to display the menus.

E Select the menu shown below. Use u or d to select a menu, and press OK.

Select Fax Mode > Polling. Press x to return to the fax mode top screen.

F Press x to receive the fax.

Note:
If Auto Answer mode is turned on, the received fax data is automatically printed, and you do not have to proceed to
step 7.

G Press OK to print the received fax.

Printing Reports

Follow the instructions below to print a fax report.

A Load plain paper in the rear paper feed.
& “Loading Paper and Envelopes” on page 20

B Press K to enter the fax mode.

C Press x to display the menus.

D Select the menu shown below. Use u or d to select a menu, and press OK.

Select Fax Settings > Print Report.

E Select the item you want to print.

Note:
Only Fax Log can be viewed on the screen.

F Press x to print the report you selected.

Fax Mode Menu List

Refer to the section below for the Fax mode menu list.
& “Fax Mode” on page 74
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Menu List of Control Panel

You can use this product as a printer, copier, scanner, and fax. When using one of these functions, except the printer
function, select your desired function by pressing the corresponding Mode button on the control panel. Each mode’s
main screen appears as you select the mode.

Copy Mode

Note:
Depending on the model, some functions may not be available.

Press x to see the menu.

Setting Item Setting item and description

Layout With Border, ID Card Copy

Reduce/Enlarge Actual Size, Auto Fit Page, Custom

Paper Size A4, Legal

Paper Type Plain Paper, Matte

Quality Draft, Standard Quality, Best

Copy Density -4 to +4

Restore Default
Settings

Reset Fax Send/
Receive Settings

Initializes Fax Send/Receive settings to the factory default settings.

Reset Fax Data
Settings

Initializes Fax Data settings to the factory default settings.

Reset Wi-Fi/
Network Settings

Initializes Wi-Fi/Network settings to the factory default settings.

Reset All except
Wi-Fi/Network
Settings

Initializes all settings except for Wi-Fi/Network settings to the factory default
settings.

Reset All except
Wi-Fi/Network &
Fax Settings

Initializes all settings except for Wi-Fi/Network & Fax settings to the factory default
settings.

Reset All Settings Initializes all settings to the factory default settings.
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Setting Item Setting item and description

Wi-Fi/Network
Settings

Wi-Fi Setup See the online Network Guide. You can access the Wi-Fi Setup menus directly by
pressing the  button.

Check Wi-Fi/
Network
Connection

You can check the network connection status, and print the report. If there is any
problem with the connection, the report helps you find the solution.

Confirm Wi-Fi/
Network Settings

You can see the current network settings.

Print Wi-Fi/
Network Status
Sheet

You can print a network status sheet.

Maintenance Ink Level Checks the status of the ink cartridge.

Nozzle Check Prints a nozzle check pattern to check the condition of the print head.

Head Cleaning Cleans the print head to improve the condition of the print head.

Head Alignment Adjusts the alignment of the print head.

Ink Cartridge
Replacement

Select to replace the ink cartridge.

Sound On, Off

LCD Contrast +1 to +16

Scroll Speed Fast, Standard, Slow

Power Off Timer Off, 30 minutes, 1h, 2h, 4h, 8h, 12h

Sleep Timer 3minutes, 5minutes, 10minutes

Date/Time Date, Time

Daylight Saving
Time

On, Off

Country/Region -

Language -

Fax Mode

Note:
These functions are available only for Fax capable models.

Press x to see the menu.

Menu Setting item Description

Quality - Select this option to change the quality for fax data you are sending.

Contrast - Select this option to change the contrast for fax data you are sending.
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Menu Setting item Description

Send Fax Later - & “Sending a fax at a specified time” on page 68.

Fax Mode Sending Default mode to send faxes normally.

Polling & “Receive a fax by polling” on page 71.
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Menu Setting item Description

Fax Settings Print Report Fax Log: Prints or displays the communication log.

Last Transmission: Prints a communication-in log for the previous transmission
or the previous polling results received.

Speed Dial List: Prints the speed dial list.

Group Dial List: Prints the group dial list.

Reprint Faxes: Reprints from the latest fax received. When the memory is full, the
oldest faxes are erased first.

Protocol Trace: Prints the protocol for the latest communication.

Speed Dial Setup & “Setting Up Fax Features” on page 65.

Group Dial Setup

Send/Receive
Setup

Auto Answer: & “Setting up to receive faxes automatically” on page 70.

Quality: Select this option to change the quality for fax data you are sending.

Contrast: Select this option to change the contrast for fax data you are sending.

Paper Size: Indicates the size of paper used for printing received faxes and fax
reports.

Auto Reduction: Indicates whether large received faxes are reduced in size to fit
on A4-size, or printed at their original size on multiple sheets.

Last Transmission Report: Indicates whether or when the product prints a report
for outgoing faxes. Select Off to turn off report printing, select On Error to print
reports only when an error occurs, or select On Send to print reports for every fax
you send.

Communication DRD: Indicates the type of answer ring pattern you want to use to receive faxes. To
select an option other than All (or Off), you must set up your phone system to use
different ring patterns. This option may be On or Off depending on the region.

ECM: Indicates whether or not to use Error Correction Mode to automatically
correct fax data sent/received with errors due to the line or any other problems.
Color faxes cannot be sent when ECM is off.

Fax Speed: Indicates the speed at which you transmit and receive faxes.

Rings to Answer: Indicates the number of rings that must occur before the
product automatically receives a fax. Depending on the region, this setting may
not be displayed.

Dial Tone Detection: When this is set to On, the product starts dialing after it
detects a dial tone. It may not be able to detect a dial tone when a PBX (Private
Branch Exchange) or a TA (Terminal Adapter) is connected. In that case, set to Off.
However, doing so may drop the first digit of a fax number and send the fax to the
wrong number.

Dial Mode: Indicates the type of phone system to which you have connected the
product. Depending on the region, this setting may not be displayed.

Check Fax
Connection

Checks the status of your fax connection.

Header & “Creating header information” on page 66.
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Menu Setting item Description

Restore Default
Settings

- & “Copy Mode” on page 73.

Wi-Fi/Network
Settings

-

Maintenance -

Scan Mode

Menu Setting and Options

Scan to PC & “Basic Scanning from the Control Panel” on page 46

Scan to PC (PDF)

Scan to PC (Email)

Scan to PC (WSD) This feature is only available for English versions of Windows 7/Vista.

Press x to see the menu.

Menu Description

Restore Default Settings & “Copy Mode” on page 73.

Wi-Fi/Network Settings

Maintenance
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Replacing Ink Cartridges

Ink Cartridge Safety Instructions, Precautions, and
Specifications

Safety instructions

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the ink supply port.
If ink gets on your skin, wash the area thoroughly with soap and water.
If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a
thorough flushing, see a doctor immediately.
If ink gets into your mouth, spit it out immediately and see a doctor right away.

❏ Do not remove or tear the label on the cartridge; this can cause leakage.

❏ Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

❏ Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.
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❏ Do not touch the green IC chip or the small window on the cartridge. Doing so may prevent normal operation and
printing.

❏ Do not leave the product with the ink cartridge removed or do not turn off the product during cartridge
replacement. Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

Precautions on ink cartridge replacement

Read all of the instructions in this section before replacing the ink cartridge.

❏ Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic product behavior. Information about non-genuine ink levels may
not be displayed.

❏ Gently shake an ink cartridge four or five times before opening the package.

❏ Do not shake an ink cartridge too vigorously; otherwise ink may leak from the cartridge.

❏ This product uses ink cartridges equipped with an IC chip that monitors information such as the amount of
remaining ink for a cartridge. This means that even if the cartridge is removed from the product before it is
expended, you can still use the cartridge after reinserting it back into the product. However, when reinserting a
cartridge, some ink may be consumed to guarantee product performance.

❏ You cannot use the cartridge that came with your product for the replacement.

❏ To maintain optimum print head performance, some ink is consumed from a cartridge not only during printing
but also during maintenance operations such as ink cartridge replacement and print head cleaning.

❏ If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area from dirt and dust. Store
the ink cartridge in the same environment as the product. When storing the cartridge, be sure that its label
identifying the color of the ink cartridge is facing upward. Do not store ink cartridges upside down.

❏ The ink supply port is equipped with a valve designed to contain the release of excess ink; there is no need to supply
your own covers or plugs. However, careful handling is recommended. Do not touch the supply port of the ink
cartridge or its surrounding area.

❏ For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. An ink cartridge with
low ink status may not be used when reinserted.
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❏ Do not open the ink cartridge package until you are ready to install it in the product. The cartridge is vacuum
packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal printing
may not be possible.

❏ If an ink cartridge is running low, prepare a new ink cartridge.

❏ Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

❏ You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or
you may not be able to print.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

Ink Cartridge Specifications

❏ Epson recommends using the ink cartridge before the date printed on the package.

❏ The ink cartridge packaged with your product is partly used during initial setup. In order to produce high quality
printouts, the print head in your product will be fully charged with ink. This one-off process consumes a quantity
of ink and therefore the cartridge may print fewer pages compared to subsequent ink cartridges.

❏ Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

❏ To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the cartridge when your product indicates to replace the cartridge. The yields quoted for you do not
include this reserve.

❏ Although the ink cartridges may contain recycled materials, this does not affect product function or performance.

Checking the Ink Cartridge Status

For Windows

Note:
When an ink cartridge is running low, the Low Ink Reminder screen automatically appears. You can also check the ink
cartridge status from this screen. If you do not want to display this screen, first access the printer driver and then click the
Maintenance tab, and then Monitoring Preferences. On the Monitoring Preferences screen, clear the See Low Ink
Reminder alerts check box.

To check the ink cartridge status, do one of the following:

❏ Open the printer driver, click the Main tab, and then click the Ink Level button.
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❏ Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
& “From the shortcut icon on the taskbar” on page 28

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button. A graphic
displays the ink cartridge status.

Note:
❏  If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the

Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

❏ Depending on current settings, the simplified status monitor may be displayed. Click the Details button to display the
window above.

❏ The ink level displayed is an approximate indication.

For Mac OS X

You can check the ink cartridge status using EPSON Status Monitor. Follow the steps below.

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 28
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B Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

Note:
❏ The graphic displays the ink cartridge status when EPSON Status Monitor was first opened. To update the ink cartridge

status, click Update.

❏ The ink level displayed is an approximate indication.

Using the control panel

A Press x to display the menus.

B Select Maintenance > Ink Level.

Note:
The ink level displayed is an approximate indication.
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Replacing an Ink Cartridge

Using the control panel

A When prompted to replace an ink cartridge, open the scanner unit and press OK. The ink cartridge holder
moves to the ink cartridge replacement position.
When you replace an ink cartridge before it is expended, follow the instruction below.
Press x and select Maintenance > Ink Cartridge Replacement.

c Important:
❏ Do not lift up the scanner unit when the document cover is open.

❏ Do not move the ink cartridge holder by hand; otherwise, you may damage the product.

     User’s Guide

Replacing Ink Cartridges

83



B Pinch and remove the ink cartridge.

Note:
A removed ink cartridge may have ink around the ink supply port, so be careful not to get any ink on the surrounding
area when removing the cartridge.

C Gently shake a new replacement cartridge four or five times and then unpack.

c Important:
❏ Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

❏ Do not touch the green IC chip or the small window on the cartridge. Doing so may prevent normal
operation and printing.
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D Remove only the yellow tape.

c Important:
❏ You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may

decline or you may not be able to print.

❏ If you have installed an ink cartridge without removing the yellow tape, take the cartridge out of the
product, remove the yellow tape, and then reinstall it.

❏ Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

❏ Do not remove or tear the label on the cartridge; otherwise, ink will leak.

E Insert the cartridge and press it until it clicks.

F Close the scanner unit slowly and press OK. Ink charging starts.

Note:
❏ The P light continues to flash while the product is charging ink. Do not turn off the product during ink charging.

If the ink charging is incomplete, you may not be able to print.

❏ If you had to replace an ink cartridge during copying, to ensure copy quality after ink charging is finished, cancel
the job that is copying and start again from placing the originals.
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Ink cartridge replacement is complete. The product will return to its previous status.

For Windows

When you need to replace an expended ink cartridge, click How to in the status monitor window. Follow the on-screen
instructions to replace the cartridge.
For more information on using your computer to replace the ink cartridge, see the section below.
& “For Windows” on page 104.

If you need to replace an ink cartridge before it is low or expended, click the button on the Maintenance tab in your
printer driver.
& “Accessing the printer driver for Windows” on page 27

For more information on using the printer utilities, see the online help.

For Mac OS X

When you need to replace an expended ink cartridge, click How to in the status monitor window. Follow the on-screen
instructions to replace the cartridge.
For more information on using your computer to replace the ink cartridge, see the section below.
& “For Mac OS X” on page 105.
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If you need to replace an ink cartridge before it is low or expended, access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 28.

For more information on using the printer utilities, see the online help.
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Maintaining Your Product and Software

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by
checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or from the product by
using the buttons.

Using the Nozzle Check utility for Windows

Follow the steps below to use the Nozzle Check utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the rear paper feed.

C Right-click the product icon on the taskbar, then select Nozzle Check.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 28

D Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the rear paper feed.

C Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 28

D Click the Nozzle Check icon.

E Follow the on-screen instructions.
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Using the control panel

Follow the steps below to check the print head nozzles using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the rear paper feed.

C Press x to display the menus.

D Select Maintenance.

E Select Nozzle Check and follow the instructions in the LCD screen to print a nozzle check pattern.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality
problems, such as gaps or missing segments in the test lines, the print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a
misaligned print head.

& “Cleaning the Print Head” on page 90 
& “Aligning the Print Head” on page 91
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Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve these problems by
cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer driver or from the
product by using the buttons.

c Important:
Do not turn off the product during head cleaning. If the head cleaning is incomplete, you may not be able to print.

Note:
❏ Do not open the scanner unit during head cleaning.

❏ Because print head cleaning uses some ink from the cartridge, clean the print head only if quality declines; for example,
if the printout is blurry or some segments are missing.

❏ Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.

❏ When ink is low you may not be able to clean the print head. When ink is expended you cannot clean the print head.
Replace the ink cartridge first.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

❏ For products with fax function, if print quality has not improved after repeating this procedure about four times, leave
the product on and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.
If print quality has still not improved, contact Epson support.

❏ For products without fax function, if print quality has not improved after repeating this procedure about four times,
turn the product off and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning if
necessary. If print quality has still not improved, contact Epson support.

Using the Head Cleaning utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Right-click the product icon on the taskbar, then select Head Cleaning.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 28

C Follow the on-screen instructions.

Using the Head Cleaning utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

A Make sure that no warnings or errors are indicated in the control panel.
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B Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 28

C Click the Head Cleaning icon.

D Follow the on-screen instructions.

Using the control panel

Follow the steps below to clean the print head using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Press x to display the menus.

C Select Maintenance.

D Select Head Cleaning.

E Follow the instructions on the LCD screen to continue.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem by using the
Print Head Alignment utility in your printer driver or by using the product buttons.

Refer to the appropriate section below.

Note:
Do not press y to cancel printing while printing a test pattern with the Print Head Alignment utility.

Using the Print Head Alignment utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure A4-size paper is loaded in the rear paper feed.
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C Right-click the product icon on the taskbar, then select Print Head Alignment.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 28

D Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure A4-size paper is loaded in the rear paper feed.

C Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 28

D Click the Print Head Alignment icon.

E Follow the on-screen instructions to align the print head.

Using the control panel

Follow the steps below to align the print head using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the rear paper feed.

C Press x to display the menus.

D Select Maintenance.

E Select Head Alignment and follow the instructions in the LCD screen to print the patterns.

     User’s Guide

Maintaining Your Product and Software

92



F Find the most solid pattern in each of #1 to #4 groups.

G Enter the pattern number for the most solid pattern in #1 group.

H Repeat step 7 for the other groups (#2 to #4).

I Finish aligning the print head.

Setting/Changing Time and Region

Follow the steps below to set the time and region using the product control panel.

Note:
This function is only available for fax capable models.

A Press x to display the menus.

B Select Maintenance.

C Select Date/Time.

D Select the date format.

E Set the date.

F Select the time format.

G Set the time.

Note:
To select daylight saving time, set Daylight Saving Time to On.

H Select Country/Region.
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I Select the region.

J Select Yes.

Note:
When the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn the power
back on.

Saving Power

The LCD screen turns black if no operations are performed for a set period.

You can adjust the time before power management is applied. Any increase will affect the product’s energy efficiency.
Please consider the environment before making any change.

Follow the steps below to adjust the time.

For Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 27

B Click the Maintenance tab, and then click the Printer and Option Information button.

C For products without fax function, select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the
Power Off Timer setting. Then click the Send button.

Note:
This function is available only with products without fax function.

D Select 3 minutes, 5 minutes, or 10 minutes as the Sleep Timer setting. Then click the Send button.

E Click the OK button.

For Mac OS X

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 28

B Click the Printer Settings button. The Printer Settings screen appears.
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C For products without fax function, select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the
Power Off Timer setting.

Note:
This function is available only with products without fax function.

D Select 3 minutes, 5 minutes, or 10 minutes as the Sleep Timer setting.

E Click the Apply button.

Using the control panel

A Press x to display the menus.

B Select Maintenance.

C For products without fax function, select Power Off Timer.

D Select Off, 30 minutes, 1h, 2h, 4h, 8h, or 12h.

E Select Sleep Timer.

F Select 3minutes, 5minutes, or 10minutes.

Cleaning the Product

Cleaning the exterior of the product

To keep your product operating at its best, clean it thoroughly several times a year by using the following instructions.

c Important:
Never use alcohol or thinner to clean the product. These chemicals can damage the product.

Note only for products without fax function:
Close the paper support and the output tray when you are not using the product to protect the product from dust.

❏ Use a soft, dry, clean cloth to clean the LCD screen. Do not use liquid or chemical cleaners.
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❏ Use a soft, dry, clean cloth to clean the surface of the scanner glass.
If straight lines appear in the printout or the scanned data, clean the left side of the scanner glass carefully.

❏ If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of glass
cleaner and a soft cloth to remove it. Wipe off all remaining liquid.

❏ Open the ADF cover and use a soft, dry, clean cloth to clean the roller and the interior of the ADF.

❏ Do not press the surface of the scanner glass with any force.

❏ Be careful not to scratch or damage the surface of the scanner glass, and do not use a hard or abrasive brush to clean
it. A damaged glass surface can decrease the scan quality.

Cleaning the interior of the product

To keep your print results at their best, clean the roller inside by using the following procedure.

!Caution:
Be careful not to touch the parts inside the product.
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c Important:
❏ Be careful to keep water away from the electronic components.

❏ Do not spray the inside of the product with lubricants.

❏ Unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is
needed.

A Make sure that no warnings or errors are indicated in the control panel.

B Load several sheets of A4-size plain paper in the rear paper feed.

C Press r to enter the copy mode.

D Press x to make a copy without placing a document on the scanner glass.

E Repeat step 4 until the paper is not smeared with ink.

Transporting the Product

If you move the product some distance, you need to prepare it for transportation in its original box or one of a similar
size.

c Important:
❏ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;

otherwise ink may leak.

❏ Leave the ink cartridge installed. Removing the cartridge can dry out the print head and may prevent the product
from printing.

A Remove all paper from the rear paper feed and make sure the product is off.

B Open the scanner unit and make sure the ink cartridge holder is in the home position on the right.
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Note:
If the ink cartridge holder is not in the home position on the right, turn on the product and wait until the ink cartridge
holder locks in the far right position. Then turn off the product.

C Secure the ink cartridge holder to the case with tape as shown, then close the scanner unit.

Note:
Do not place tape on the white flat cable inside the product.

D Unplug the power cord from the outlet, then disconnect all cables from the product.

E Close the paper support and the output tray.

F Repack the product in the box, using the protective materials that came with it.

Note:
❏ Keep the product level during transport.

❏ Be sure to remove the protective materials from the product before using it again.

Checking and Installing Your Software

Checking the software installed on your computer

To use the functions described in this User’s Guide, you need to install the following software.

❏ Epson Driver and Utilities

❏ Epson Event Manager

Follow the steps below to check that the software is installed on your computer.
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For Windows

A Windows 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

B Windows 7 and Vista: Click Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

C Check the list of currently installed programs.

For Mac OS X

A Double-click Macintosh HD.

B Double-click the Epson Software folder in the Applications folder and check the contents.

Note:
❏ The Applications folder contains software provided by third parties.

❏ To check that the printer driver is installed, click System Preferences on the Apple menu and then click Print & Scan
(for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5). Then locate your product in the Printers list box.

Installing the software

Insert the product software disk that came with your product and select the software you want to install on the Software
Select screen.

Uninstalling Your Software

You may need to uninstall and then reinstall your software to solve certain problems or if you upgrade your operating
system.

See the following section for information on determining what applications are installed.
& “Checking the software installed on your computer” on page 98

For Windows

Note:
❏ For Windows 7 and Vista, you need an administrator account and password if you log on as a standard user.

❏ For Windows XP, you must log on to a Computer Administrator account.

A Turn off the product.
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B Disconnect the product’s interface cable from your computer.

C Do one of the following.

Windows 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

D Do one of the following.

Windows 7 and Vista: Click Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

E Select the software you want to uninstall such as your product’s driver and the application from the list
displayed.

F Do one of the following.

Windows 7: Click Uninstall/Change or Uninstall.

Windows Vista: Click Uninstall/Change or Uninstall, and then click Continue in the User Account Control
window.

Windows XP: Click Change/Remove or Remove.

Note:
If you chose to uninstall your product’s printer driver in step 5, select the icon for your product and then click
OK.

G When the confirmation window appears, click Yes or Next.

H Follow the on-screen instructions.

In some cases, a message may appear to prompt you to restart your computer. If so, make sure I want to restart my
computer now is selected and click Finish.

For Mac OS X

Note:
❏ To uninstall your software you need to download the Uninstaller.

Access the site at:
http://www.epson.com
Next, select the support section of your local Epson Web site.

❏ To uninstall applications, you must log on to a Computer Administrator account.
You cannot uninstall programs if you log on as a limited account user.

❏ Depending on the application, the Installer may be separated from the Uninstaller.
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A Quit all running applications.

B Double-click the Uninstaller icon in your Mac OS X hard drive.

C Select the check boxes for the software you want to uninstall, such as the printer driver and the application, from
the list displayed.

D Click Uninstall.

E Follow the on-screen instructions.

If you cannot find the software you want to uninstall in the Uninstaller window, double-click the Applications folder
in your Mac OS X hard drive, select the application you want to uninstall, and then drag it to the Trash icon.

Note:
If you uninstall the printer driver and the name of your product remains in the Print & Scan (for Mac OS X 10.7) or Print &
Fax (for Mac OS X 10.6 or 10.5) window, select the name of your product and click the - remove button.
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Error Indicators

Error Messages on the Control Panel

This section describes the meaning of messages displayed on the LCD screen.

Error Messages Solutions

Paper jam
Press OK. If the error does not clear, remove the paper by
hand.

Remove the jammed paper.

& “Paper Jams” on page 107

Paper jam in the ADF. Remove the jammed paper.

Communication error. Make sure the cable is connected,
then try again.

Make sure the computer is connected correctly. If the error
messages still appears, make sure that scanning software is
installed on your computer and that the software settings are
correct.

Printer error
Paper jam. Open the scanner unit and remove the paper,
then turn off the printer. See your documentation.

Turn the product off and then back on. Make sure that no paper is
still in the product. If the error message still appears, contact Epson
support.

ADF Error.
Remove any objects or documents inside ADF. Turn power
off. See documentation.

Printer error
See your documentation.

Scanner error
See your documentation.

Turn the product off and then back on. If the error message still
appears, contact Epson support.

A fax error has occurred.
See your documentation.

A printer’s ink pad is nearing the end of its service life.
Please contact Epson Support.

Press OK to resume printing. The message will be displayed until
the ink pad is replaced.

Contact Epson support to replace ink pads before the end of their
service life. When the ink pads are saturated, the product stops and
Epson support is required to continue printing.

A printer’s ink pad is at the end of its service life. Please
contact Epson Support.

Contact Epson support to replace the ink pad.

No dial tone.
Fax job incomplete.

Make sure the phone cable is connected correctly and the phone
line works.

& “Connecting to a Phone Line” on page 61

If you connected the product to a PBX (Private Branch Exchange)
phone line or Terminal Adapter, turn off the Dial Tone
Detection.

& Press K and then x. Then select Fax Settings >
Communication > Dial Tone Detection.
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Error Messages Solutions

Recovery Mode The firmware update has failed. You will need to re-attempt the
firmware update. Ready a USB cable and visit your local Epson
website for further instructions.
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Troubleshooting for Printing/Copying

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, then apply likely solutions
until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving,
the control panel, or the status monitor. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printing problem not related to print quality, or a paper
feeding problem, or if the product does not print at all, refer to the appropriate section.

To solve a problem, you may need to cancel printing.
& “Canceling printing” on page 32

Checking product status

If a problem occurs while printing, an error message will appear in the status monitor window.

If an error message appears indicating the product’s ink pads are nearing the end of their service life, contact Epson
support to replace them. The message will be displayed at regular intervals until the ink pads are replaced. When the
product’s ink pads are saturated, the product stops and Epson support is required to continue printing.

For Windows

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
& “From the shortcut icon on the taskbar” on page 28

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button.
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When you access EPSON Status Monitor 3, the following window appears:

Note:
❏ If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the

Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

❏ Depending on current settings, the simplified status monitor may be displayed. Click the Details button to display the
window above.

EPSON Status Monitor 3 provides the following information:

❏ Current Status: 
If the ink is low or expended, the How to button appears in the EPSON Status Monitor 3 window. Clicking How to
displays ink cartridge replacement instructions and moves the ink cartridge holder to the ink cartridge
replacement position.

❏ Ink Level: 
EPSON Status Monitor 3 provides a graphic display of the ink cartridge status.

❏ Information: 
You can view information about the installed ink cartridge by clicking Information.

❏ Technical Support: 
Click Technical Support to access the Epson technical support website.

❏ Print Queue: 
You can view Windows Spooler by clicking Print Queue.

For Mac OS X

Follow these steps to access EPSON Status Monitor.

     User’s Guide

Troubleshooting for Printing/Copying

105



A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 28

B Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

You can also use this utility to check the ink cartridge status before printing. EPSON Status Monitor displays the
ink cartridge status at the time it was opened. To update the ink cartridge status, click Update.
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When ink is low or expended, a How to button appears. Click How to, and EPSON Status Monitor will lead you step by
step through the ink cartridge replacement procedure.

Paper Jams

!Caution:
Never touch the buttons on the control panel while your hand is inside the product.

Note:
❏ Cancel the print job if prompted by a message from the LCD screen or the printer driver.

❏ After you have removed the jammed paper, press the button indicated in the LCD screen.
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Removing jammed paper from inside the product

A Open the scanner unit.

c Important:
Do not lift up the scanner unit when the document cover is open.

B Remove all of the paper inside, including any torn pieces.

C Close the scanner unit slowly.
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Removing jammed paper from the Automatic Document Feeder 
(ADF)

A Remove the stack of paper from the ADF input tray.

B Open the ADF cover.

c Important:
Make sure you open the ADF cover before removing jammed paper. If you do not open the cover, the product
may be damaged.

C Carefully remove the jammed paper.

D Open the Automatic Document Feeder (ADF).
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E Remove all of the paper inside, including any torn pieces.

F Close the Automatic Document Feeder (ADF).

G Raise the ADF input tray.

H Carefully remove the jammed paper.

I Return the ADF input tray to its original position, and close the ADF cover.

Preventing paper jams

If your paper jams frequently, check the following.

❏ The paper is smooth, not curled or wrinkled.
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❏ You are using high-quality paper.

❏ The printable side of the paper is face up in the rear paper feed.

❏ The paper stack was fanned before loading.

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 18

❏ The edge guides are snug against the edges of the paper.

❏ The product is on a flat, stable surface that extends beyond the base in all directions. The product will not operate
properly if it is tilted.

Reprinting after a paper jam (for Windows only)

After you cancel the print job because of a paper jam, you can reprint it without reprinting pages that have already been
printed.

A Solve the paper jam.
& “Paper Jams” on page 107

B Access the printer settings.
& “Accessing the printer driver for Windows” on page 27

C Select the Print Preview check box in the Main window of your printer driver.

D Make the settings that you want to use to print.

E Click OK to close the printer settings window, and then print your file. Print Preview window opens.

F Select a page that has already been printed in the page list box on the left side, and then select Remove Page from
the Print Options menu. Repeat this step for all the pages that have already been printed.

G Click Print on the Print Preview window.

Print Quality Help

If you are having print quality problems, then compare it with the illustrations below. Click the caption under the
illustration that best resembles your prints.
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Good sample & “Horizontal banding” on page 112

& “Vertical banding or misalignment” on page 112 & “Blurry, smeared, or scuffed printout” on page 113

Horizontal banding

❏ Make sure the printable side (the whiter side) of the paper is face up in the rear paper feed.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& “Cleaning the Print Head” on page 90

❏ For best results, use up ink cartridge within six months of opening the package.

❏ Try to use genuine Epson ink cartridges.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 18

❏ If banding appears at intervals of 2.5 cm, run the Print Head Alignment utility.
& “Aligning the Print Head” on page 91

❏ If a moire (cross-hatch) pattern appears on your copy, change the Reduce/Enlarge setting in the LCD menu or
shift the position of your original.

❏ If there is problem with copy quality, clean the exterior of the product.
& “Cleaning the exterior of the product” on page 95

Vertical banding or misalignment

❏ Make sure the printable side (the whiter side) of the paper is face up in the rear paper feed.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& “Cleaning the Print Head” on page 90

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 91
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❏ For Windows, clear the High Speed check box from the More Options window in your printer driver. See the
online help for details.
For Mac OS X, select Off from the High Speed Printing. To display the High Speed Printing, click through the
following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or
10.5), your product (in the Printers list box), Options & Supplies, and then Driver.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 18

❏ If there is problem with copy quality, clean the exterior of the product.
& “Cleaning the exterior of the product” on page 95

Blurry, smeared, or scuffed printout

❏ Try to use genuine Epson ink cartridges and paper recommended by Epson.

❏ Make sure the product is on a flat, stable surface that extends beyond the base in all directions. The product will not
operate properly if it is tilted.

❏ Make sure your paper is not damaged, dirty, or too old.

❏ Make sure your paper is dry and the printable side (the whiter side) is face up in the rear paper feed.

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 18

❏ Remove each sheet from the output tray as it is printed.

❏ Do not touch or allow anything to come into contact with the printed side of paper with a shiny finish. To handle
your prints, follow the instructions of the paper.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& “Cleaning the Print Head” on page 90

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 91

❏ If the paper is smeared with ink after printing, clean the interior of the product.
& “Cleaning the interior of the product” on page 96

❏ If you have just replaced an ink cartridge, make sure the date on the box. If you have not used the product for a long
time, Epson recommends replacing the ink cartridge.
& “Replacing Ink Cartridges” on page 78

❏ If there is problem with copy quality, clean the exterior of the product.
& “Cleaning the exterior of the product” on page 95
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Miscellaneous Printout Problems

Incorrect or garbled characters

❏ Clear any stalled print jobs.
& “Canceling printing” on page 32

❏ Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 99

Incorrect margins

❏ Make sure that the paper is loaded into the rear paper feed correctly.
& “Loading Paper and Envelopes” on page 20

❏ Check the margin settings in your application. Make sure that the margins are within the printable area of the
page.
& “Printable area” on page 131

❏ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 99

Printout has a slight slant

❏ Make sure that the paper is loaded into the rear paper feed correctly.
& “Loading Paper and Envelopes” on page 20

❏ If Draft is selected in Quality in the Main window in your printer driver (for Windows), or Draft is selected in
Print Quality in Print Settings (for Mac OS X), select another setting.

Size or position of copied image is incorrect

❏ Make sure the paper size, layout, or reduce/enlarge setting selected in the control panel matches the paper used.

❏ If the edges of the copy are cropped off, move the original slightly away from the corner.

❏ Clean the scanner glass.
& “Cleaning the exterior of the product” on page 95
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Inverted image

❏ For Windows, clear the Mirror Image check box from the More Options window of your printer driver, or turn
off the Mirror Image setting in your application.
For instructions, see the online help for your printer driver or for your application.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 99

Blank pages print

❏ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.

❏ For Windows, check the Skip Blank Page setting by clicking the Extended Settings button on the Maintenance
window of the printer driver.
For Mac OS X, select On from the Skip Blank Page. To display the Skip Blank Page, click through the following
menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your
product (in the Printers list box), Options & Supplies, and then Driver.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 99

Printed side is smeared or scuffed

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

❏ Make several copies without placing a document on the scanner glass.
& “Cleaning the interior of the product” on page 96

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 99

Printing is too slow

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 18

❏ For Windows, choose a lower Quality in the printer driver Main window.
For Mac OS X, choose a lower Print Quality in the Print Settings dialog box from your printer driver’s Print dialog
box.
& “Accessing the printer driver for Windows” on page 27 
& “Accessing the printer driver for Mac OS X” on page 28

❏ Close any unnecessary applications.
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❏ If you print continuously for an extended period, the printing may be extremely slow. This is to slow down the
printing speed and prevent the product mechanism from overheating and being damaged. If this happens, you
can continue to print, but we recommend stopping and leaving the product idle for at least 30 minutes with the
power on. (The product does not recover with the power off.) After you restart, the product will print at normal
speed.

❏ Uninstall the printer driver, then reinstall it.
&  “Uninstalling Your Software” on page 99

If you try all of the methods above and cannot solve the problem, see the following:
& “Increasing the Print Speed (For Windows Only)” on page 119

Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with the paper for more information.

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 18

❏ Paper is not jammed inside the product. If it is, remove the jammed paper.
& “Paper Jams” on page 107

❏ The ink cartridge is not expended. If the cartridge is expended, replace it.
& “Replacing an Ink Cartridge” on page 83

❏ You have followed any special loading instructions that came with your paper.

Multiple pages feed

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 18

❏ Make sure the edge guides are snug against the edges of the paper.

❏ Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite side before
loading.

❏ Remove the stack of paper and make sure that the paper is not too thin.
& “Paper” on page 130

❏ Fan the edges of the stack to separate the sheets, then reload the paper.
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❏ If too many copies of a file are being printed, check the Copies setting in your printer driver as follows, and also
check in your application.
For Windows, check the Copies setting on the Main window.
Mac OS X, check the Copies setting in the Print dialog.

Paper is improperly loaded

If you have loaded the paper too far into the product, the product cannot feed the paper correctly. Turn the product off
and gently remove the paper. Then turn the product on and reload the paper correctly.

Paper is not ejected fully or is wrinkled

❏ If the paper does not eject fully, press x to eject the paper. If the paper is jammed inside the product, remove it by
referring to the following section.
& “Paper Jams” on page 107

❏ If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The Product Does Not Print

All lights are off

❏ Press the P button to make sure the product is on.

❏ Make sure that the power cord is securely plugged in.

❏ Make sure that your outlet works and is not controlled by a wall switch or timer.

Only the power light is on

❏ Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

❏ If you are using the USB interface, make sure your cable meets the USB or Hi-Speed USB standards.

❏ If you are connecting the product to your computer via a USB hub, connect the product to the first-tier hub from
your computer. If the printer driver is still not recognized on your computer, try to directly connect the product to
your computer without the USB hub.

❏ If you are connecting the product to your computer via a USB hub, make sure the USB hub device is recognized by
your computer.

❏ If you are trying to print a large image, your computer may not have enough memory. Try reducing the resolution
of your image or printing the image at a smaller size. You may need to install more memory in your computer.

     User’s Guide

Troubleshooting for Printing/Copying

117



❏ Users of Windows can clear any stalled print jobs from the Windows Spooler.
& “Canceling printing” on page 32

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 99

An ink error is indicated after you replace the cartridge

A Open the scanner unit.

c Important:
Do not lift up the scanner unit when the document cover is open.

B Make sure the ink cartridge holder is at the ink cartridge replacement position.
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C Remove and reinsert the ink cartridge and then continue with the ink cartridge installation.

D Close the scanner unit slowly, and press OK in the control panel.

Increasing the Print Speed (For Windows Only)

Print speed may be increased by selecting certain settings in the Extended Settings window when the printing speed is
slow. Click the Extended Settings button on your printer driver’s Maintenance window.
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The following dialog box appears.

Select the following check boxes and print speed may be increased.

❏ High Speed Copies

❏ Always spool RAW datatype

❏ Page Rendering Mode

❏ Print as Bitmap

For more details on each item, see the online help.

Other Problem

Printing plain papers quietly

When plain paper is selected for the paper type and Standard (Windows) or Normal (Mac OS X) is selected as for
quality in the printer driver, the product prints at high speed. Try choosing Quiet Mode for quieter operation which
will reduce the print speed.

For Windows, select the Quiet Mode check box in the Main window of your printer driver.
For Mac OS X, select On from the Quiet Mode. To display the Quiet Mode, click through the following menus: System
Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your product (in the
Printers list box), Options & Supplies, and then Driver.
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Troubleshooting for Scanning

Problems Indicated by Messages on the LCD Screen or
Status Light

❏ Make sure the product is connected to your computer properly.

❏ Turn off the product and turn it on again. If the problem is not solved, the product may be malfunctioning, or the
light source in the scanner unit may need to be replaced. Contact your dealer.

❏ Make sure the scanning software is fully installed.
See the paper manual for instructions on installing the scanning software.

Problems When Starting a Scan

❏ Check the status light and make sure the product is ready to scan.

❏ Make sure your cables are securely connected to the product and a working electrical outlet.
If necessary, test your product’s AC adapter by plugging in another electrical device and turning it on.

❏ Turn off the product and computer, and then check the interface cable connection between them to make sure it is
secure.

❏ Make sure you select the correct product if a scanner list appears when starting to scan.

Windows:
When you start Epson Scan using the EPSON Scan icon, and the Select Scanner list is displayed, make sure you
select the model of your product.

Mac OS X:
When you start Epson Scan from the Applications folder and the Select Scanner list is displayed, make sure you
select the model of your product.

❏ Connect the product directly to the computer’s external USB port or through one USB hub only. The product may
not work properly when connected to the computer through more than one USB hub. If the problem persists, try
connecting the product directly to the computer.

❏ If more than one product is connected to your computer, it may not work. Connect only the product you want to
use, and then try scanning again.

❏ If the scanning software does not work properly, uninstall the software first and then reinstall it as described in the
paper manual.
& “Uninstalling Your Software” on page 99

Using the Automatic Document Feeder (ADF)

❏ Check the ADF light and make sure the ADF is ready to scan.
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❏ Make sure there are no originals on the scanner glass.

❏ If the document cover or ADF cover is open, close it and try scanning again.

❏ Make sure you have selected either Office Mode or Professional Mode in Epson Scan.

❏ Make sure your cables are securely connected to the product and a working electrical outlet.

❏ If the ADF light is on and your originals are not fed, check that there is no foreign object inside the hole on the left
front corner of the scanner glass.

Using the button

Note:
Depending on the product, the scanning function may not be available when using the button.

❏ Check if you have assigned a program to the button.
& “Epson Event Manager” on page 60

❏ Make sure Epson Scan and Epson Event Manager are installed correctly.

❏ If you have clicked the Keep Blocking button in the Windows Security Alert window during or after installation of
the Epson Software, unblock Epson Event Manager.
& “How to unblock Epson Event Manager” on page 122

❏ Mac OS X:
Make sure you are logged on as the user who installed the scanning software. Other users must first start Epson
Scanner Monitor in the Applications folder and then press a button to scan.

How to unblock Epson Event Manager

A Click Start or the start button, and then point to Control Panel.

B Do one of the following.

❏ Windows 7:
Select System and Security.

❏ Windows Vista:
Select Security.

❏ Windows XP:
Select Security Center.

C Do one of the following.

❏ Windows 7 and Windows Vista:
Select Allow a program through Windows Firewall.

❏ Windows XP:
Select Windows Firewall.
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D Do one of the following.

❏ Windows 7:
Confirm that the check box for EEventManager Application is selected in the Allowed programs and
features list.

❏ Windows Vista:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Program or port list.

❏ Windows XP:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Programs and Services list.

E Click OK.

Using scanning software other than Epson Scan driver

❏ If you are using any TWAIN-compliant programs, such as Adobe Photoshop Elements, make sure that the correct
product is selected as the Scanner or Source setting.

❏ If you cannot scan using any TWAIN-compliant scanning programs, such as Adobe Photoshop Elements,
uninstall the TWAIN-compliant scanning program and then reinstall it.
& “Uninstalling Your Software” on page 99

Problems When Feeding Paper

The paper gets dirty

You may need to clean the product.
& “Cleaning the Product” on page 95

Multiple sheets of paper are fed

❏ If you load unsupported paper, the product may feed more than one sheet of paper at a time.
& “Automatic Document Feeder (ADF) specifications” on page 132

❏ You may need to clean the product.
& “Cleaning the Product” on page 95

The paper jams in the Automatic Document Feeder (ADF) 

Remove the jammed paper inside the ADF.
& “Removing jammed paper from the Automatic Document Feeder (ADF)” on page 109
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Problems With Scanning Time

❏ Computers with Hi-Speed external USB ports can scan faster than those with external USB ports. If you are using a
Hi-Speed external USB port with your product, make sure it meets the system requirements.
& “System Requirements” on page 129

❏ Scanning at a high resolution takes a long time.

Problems With Scanned Images

Scan quality is unsatisfactory

Scan quality can be improved by changing the current settings or adjusting the scanned image.
& “Image Adjustment Features” on page 43

An image on the back of your original appears in your scanned image

If your original is printed on thin paper, images on the back may be visible to the product and appear in your scanned
image. Try scanning the original with a piece of black paper placed on the back of it. Also make sure the Document
Type and Image Type settings are correct for your original.

Characters are distorted or blurred

❏ In Office Mode or Home Mode, select the Text Enhancement check box.

❏ Adjust the Threshold setting.

Home Mode:
Select Black&White as the Image Type setting, click the Brightness button, and then try adjusting the Threshold
setting.

Office Mode:
Select Black&White as the Image Type setting, and then try adjusting the Threshold setting.

Professional Mode:
Select Black & White as the Image Type setting and click the + (Windows) or r (Mac OS X) button next to Image
Type. Make the appropriate Image Option setting and then try adjusting the Threshold setting.

❏ Increase the resolution setting.

Characters are not recognized correctly when converted into editable text
(OCR)

Place the document so that it is straight on the scanner glass. If the document is skewed, it may not be recognized
correctly.
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Ripple patterns appear in your scanned image

A ripple or cross-hatch pattern (known as moiré) may appear in a scanned image of a printed document.

❏ Rotate your original document.

❏ Rotate the scanned image using the application software after scanning.

❏ Select the Descreening check box.

❏ In Professional Mode, change a resolution setting and scan again.

Uneven color, smears, dots, or straight lines appear in your image

You may need to clean the interior of the product.
& “Cleaning the Product” on page 95

The scanning area or direction is unsatisfactory

The edges of your original are not scanned

❏ If you are scanning using thumbnail preview in Home Mode or Professional Mode, move the document or photo
6 mm (0.2 inch) away from the horizontal and vertical edges of the scanner glass to avoid cropping.

❏ If you are scanning using the button or using normal preview in Office Mode, Home Mode, or Professional Mode,
move the document or photo about 3 mm (0.12 inch) away from the horizontal and vertical edges of the scanner
glass to avoid cropping.
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Multiple documents are scanned into a single file

Position documents at least 20 mm (0.8 inch) apart from each other on the scanner glass.

Cannot scan the area you want

Depending on the documents, you may not be able to scan the area you want. Use normal preview in Office Mode,
Home Mode, or Professional Mode and create marquees on the area you want to scan.

Cannot scan in the direction you want

Click Configuration, select the Preview tab, and then clear the Auto Photo Orientation check box. Then, place your
documents correctly.

Problems Remain After Trying All Solutions

If you have tried all the solutions and have not solved the problem, initialize the Epson Scan settings.

Click Configuration, select the Other tab, and then click Reset All.
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Troubleshooting for Faxing

Cannot send and receive fax

❏ Make sure the phone cable is connected correctly and check that the phone line works. You can check the line
status by using the Check Fax Connection function.
& “Connecting to a Phone Line” on page 61

❏ If the fax did not send, make sure that the recipient’s fax machine is turned on and working.

❏ If this product is not connected to a phone and you want to receive faxes automatically, make sure you turn on auto
answer.
& “Receiving Faxes” on page 70

❏ If you are using the Automatic Document Feeder, check that the ADF light is on. Make sure there are no originals
on the scanner glass.

❏ If the ADF light is on and your originals are not fed, check that there is no foreign object inside the hole on the left
front corner of the scanner glass.

❏ If you connected the product to a DSL phone line, you must install a DSL filter on the line otherwise you cannot
fax. Contact your DSL provider for the necessary filter.

❏ If you connected this product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, turn off Dial
Tone Detection.
& “Fax Mode” on page 74

❏ Transmission speed may be the cause of the problem. Choose a slower Fax Speed setting.
& “Fax Mode” on page 74

❏ Make sure that ECM is turned on. Color faxes cannot be sent when ECM is off.
& “Fax Mode” on page 74

Quality problems (sending)

❏ Clean the scanner glass and Automatic Document Feeder (ADF).
& “Cleaning the exterior of the product” on page 95

❏ If the fax you sent was faint or not clear, change the Resolution (or Quality depending on your model) or
Contrast in the fax settings menu.
& “Fax Mode” on page 74

❏ Make sure that ECM is turned on.
& “Fax Mode” on page 74
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Answering machine cannot answer voice calls

❏ When auto answer is turned on and an answering machine is connected to the same phone line as this product, set
the number of rings to answer for receiving faxes to a higher number than the number of rings for the answering
machine.
& “Receiving Faxes” on page 70

Incorrect time

❏ The clock may run fast/slow or may be reset after a power failure, or the power is left off for a long time. Set the
correct time.
& “Setting/Changing Time and Region” on page 93
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Product Information

Ink Cartridges

You can use the following ink cartridges with this product:

Ink Cartridge Part numbers

WF-M1561

Black 251

Color Black

Cartridge life For best results, use up ink cartridge within six months of opening the package.

Temperature Storage:
-20 to 40 ˚C (-4 to 104 ˚F)

1 month at 40 ˚C (104 ˚F)

Freezing:*
-12 ˚C (10.4 ˚F)

* Ink thaws and is usable after approximately 3 hours at 25 ˚C (77 ˚F).

System Requirements

For Windows

System PC Interface

Windows 7 (32-bit, 64-bit), Vista (32-bit, 64-bit), XP SP1 or higher(32-bit), or XP Professional
x64 Edition

Hi-Speed USB

For Mac OS X

System PC Interface

Mac OS X 10.5.8 or later Hi-Speed USB

Note:
The UNIX File System (UFS) for Mac OS X is not supported.
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Technical Specifications

Note:
Specifications are subject to change without notice.

Printer specifications

Paper path Rear paper feed, top entry

Capacity 11 mm (0.4in.)

Paper

Note:
❏ Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson

cannot attest to the quality of any non-Epson brand or type of paper. Always test samples of paper stock before
purchasing large quantities or printing large jobs.

❏ Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter problems, switch
to a higher grade of paper.

Single sheets:

Size A4 210 × 297 mm

10 × 15 cm (4 × 6 in.)

13 × 18 cm (5 × 7 in.)

A6 105 × 148 mm

A5 148 × 210 mm

B5 182 × 257 mm

9 × 13 cm (3.5 × 5 in.)

13 × 20 cm (5 × 8 in.)

20 × 25 cm (8 × 10 in.)

16:9 wide size (102 × 181 mm)

100 × 148 mm

Letter 8 1/2 × 11 in.

Legal 8 1/2 × 14 in.

Paper types Plain paper or special paper distributed by Epson

Thickness
(for plain paper)

0.08 to 0.11 mm (0.003 to 0.004 in.)

Weight
(for plain paper)

64 g/m2 (17 lb) to 90 g/m2 (24 lb)

Envelopes:

     User’s Guide

Product Information

130



Size Envelope #10 4 1/8 × 9 1/2 in.

Envelope DL 110 × 220 mm

Envelope C6 114 × 162 mm

Paper types Plain paper

Weight 75 g/m2 (20 lb) to 90 g/m2 (24 lb)

Printable area

Highlighted portions show printable area.

Single sheets Envelopes

Minimum margin

Media type Single sheets Envelopes

A 3.0 mm (0.12 in.) 3.0 mm (0.12 in.)

B 3.0 mm (0.12 in.) 5.0 mm (0.20 in.)

C 3.0 mm (0.12 in.) 21.0 mm (0.83 in.)

Note:
Depending on the type of paper, print quality may decline in the top and bottom areas of the print, or the area may be
smeared.

Scanner specifications

Scanner type Flatbed color

Photoelectric device CIS

Effective pixels 10200 × 14040 pixels at 1200 dpi

Scanning area may be restricted if resolution setting is large.
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Document size 216 × 297 mm (8.5 × 11.7 inches) A4 or US letter size

Scanning resolution 1200 dpi (main scan)

2400 dpi (sub scan)

Output resolution 50 to 4800, 7200, and 9600 dpi

(50 to 4800 dpi in 1 dpi increments)

Image data 16 bits per pixel per color internal

8 bits per pixel per color external (maximum)

Light source LED

Automatic Document Feeder (ADF) specifications

Paper input Face-up loading

Paper output Face-down ejection

Paper size A4, Letter, Legal

Paper types Plain paper

Paper weight 64 to 95 g/m2

Paper capacity Total thickness of 3 mm, up to about 30 sheets (Letter, A4) 10 sheets (Legal)

Fax specifications

The availability of this feature varies by product.

Fax type* Walk-up black and white and color fax capability

Support line Household phone line

Speed Up to 33.6 kbps

Resolution* Monochrome

Standard: 203 × 98 dpi

Fine: 203 × 196 dpi

Photo: 203 × 196 dpi

Color

Fine: 200 × 200 dpi

Photo: 200 × 200 dpi

Error correction mode CCITU/ITU Group 3 fax with error correction mode

Speed dial numbers Up to 60

Page memory Up to 180 pages (ITU-T No.1 chart)

Redial 2 times (with 1 minute interval)
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Interface RJ-11 Phone Line
RJ-11 Telephone set connection

* A color fax function is available when sending.

Network interface specification

Wi-Fi Standard: IEEE 802.11b/g/n*1

Security: WEP (64/128bit)
WPA-PSK (TKIP/AES) *2

Frequency Band: 2.4 GHz

Communication Mode: Infrastructure mode,
Ad hoc mode

Ethernet Standard: IEEE802.3i/u, IEEE802.3az*3

Communication Mode: Ethernet 100BASE-TX/10BASE-T

*1 Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.

*2 Complies with WPA2 with support for WPA/WPA2 Personal.

*3 The connected device should comply with IEEE802.3az.

Mechanical

Dimensions Storage

Width: 392 mm (15.4 inches)

Depth: 377 mm (14.8 inches)

Height: 221 mm (8.7 inches)

Printing*

Width: 392 mm (15.4 inches)

Depth: 540 mm (21.3 inches)

Height: 291 mm (11.5 inches)

Weight Approx. 5.8 kg (12.8 lb) without the ink cartridges and the power cord.

* With the output tray extension extended.

Electrical

100-240 V Model

Input voltage range 90 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.5 to 0.3 A
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Power consumption Standalone copying Approx. 11 W (ISO/IEC24712)

Ready mode Approx. 4.5 W

Sleep mode Approx. 2.3 W

Power off Approx. 0.3 W

Note:
Check the label on the back of the product for its voltage.

Environmental

Temperature Operation:
10 to 35 ˚C (50 to 95 ˚F)

Storage:
-20 to 40 ˚C (-4 to 104 ˚F)

1 month at 40 ˚C (104 ˚F)

Humidity Operation:*
20 to 80% RH

Storage:*
5 to 85% RH

* Without condensation

Standards and approvals

U.S. model:

Safety UL60950-1
CAN/CSA-C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

These equipments contains the following wireless module.
Manufacture: Askey Computer Corporation
Type: WLU6117-D69 (RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for
any failure to satisfy the protection requirements resulting from a non-recommended modification of the product.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

     User’s Guide

Product Information

134



Interface

Hi-Speed USB (Device Class for computers)
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Where To Get Help

Technical Support Web Site

Epson’s Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting
information in your product documentation. If you have a Web browser and can connect to the Internet, access the site
at:

http://support.epson.net/

If you need the latest drivers, FAQs, manuals, or other downloadables, access the site at:

http://www.epson.com

Then, select the support section of your local Epson Web site.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product documentation, contact Epson support services for assistance. If Epson support for your
area is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you normally use with your product

Note:
Depending on the product, the dial list data for fax and/or network settings may be stored in the product’s memory. Due to
breakdown or repair of a product, data and/or settings may be lost. Epson shall not be responsible for the loss of any data, for
backing up or recovering data and/or settings even during a warranty period. We recommend that you make your own
backup data or take notes.
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Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong
Limited.

Internet Home Page

Epson Hong Kong has established a local home page in both Chinese and English on the Internet to provide users with
the following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of Epson product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:

Phone: (852) 2827-8911

Fax: (852) 2827-4383
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